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ABSTRACT 

In this dissertation, the design of a WR-34 band (22-33 GHz) iris waveguide 

bandpass filter with 28 GHz center frequency and with a relative bandwidth of 2.03% 

is presented. An insertion loss method with a Chebyshev polynomial is used to 

synthesize the desired filter response. To validate the filter design, a simulation model 

is developed using the ANSYS High Frequency Structure Simulator (HFSS) software.  

The S-parameters simulation results indicate that the center frequency of the filter is 

27.995 GHz. The lower stopband frequency (fp1) is 27.71 GHz while the upper 

stopband frequency (fp2) is 28.28 GHz. Therefore, the passband ranges from 27.71 

GHz to 28.28 GHz, with a relative bandwidth of 2.03%.  The return loss for the entire 

passband is better than 7.8dB.  The corresponding upper and lower stopband insertion 

loss measurements of the filter are better than 40dB at 27.25 GHz and 28.75GHz, 

respectively.  The filter also achieves a 570 MHz bandwidth with S11 ≤ -7.8 dB and 

S21 ≤ 1dB.  In summary, the simulation results ascertain that the designed iris 

waveguide bandpass filter can serve as a viable filtering device to exploit the 

millimeter-wave band, in order to offer a large bandwidth and a fast data transfer rate 

for satisfying the growing demand of spectrum based services in future 5G mobile 

networks. 
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CHAPTER 1  

INTRODUCTION 

 

1.1 Background of Study 

Mobile communication is one of the most important and successful technologies 

in our daily life. It has become an indispensable part of over 5 million people around the 

world owing to the technology breakthroughs and attractive value propositions [1, 2]. 

The drastic rise of smart device users, increase in video streaming and growth in data 

applications such as online banking, online shopping, gaming and navigation have 

resulted in an unprecedented growth of mobile data traffic.  As a result, customers are 

always obsessed with a variety of spectrum based services. Mobile data traffic is 

predicted to grow in the foreseeable future at an 108% compound annual growth rate 

(CAGR) [2, 3] over the next ten years. Customers are expected to experience a slower 

service, and network congestion is expected to occur due to imbalance supply and 

demand. In order to support the tremendous demands on mobile data traffic, researchers 

are motivated to overcome the global bandwidth shortage by exploring the millimeter-

wave frequency spectrum for the next generation 5G mobile networks[1, 2, 4-11].  

Today, we are using the Ultra High Frequency (UHF) band ranging from 300 

MHz to 3 GHz in almost all commercial communication channels including TV, satellite 

communication, cellular, GPS, Zigbee/Bluetooh and AM/FM radio [1, 2]. On the other 

hand, there is still a large spectrum in the 3-300 GHz range remains under-utilized.  The 

spectrum in the range between 3-30 GHz is generally classified as the Super High 

Frequency (SHF) band, while 30-300 GHz is classified as the Extremely High Frequency 

(EHF) band. Since both SHF and EHF bands share similar propagation characteristics 

and their wavelengths are in the range from 1 to 100mm, the 3-300 GHz spectrum is 

normally denoted as the millimeter-wave (mm-wave) band. 
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Millimeter-wave communication is a promising technology that can be exploited 

as the wireless backbone for the next generation of 5G mobile networks. A millimeter-

wave communication system has a large  bandwidth, which can be translated to provide 

a fast data transfer rate up to multi-gigabits-per-second [1, 2, 4-11] from a distance of up 

to few kilometers to meet the growing demand of spectrum usage. Indeed, 5G 

millimeter-wave communication has a clear vision, that is to accommodate the 

environment of Internet of Things (IoT) and provide Big-Data based platforms to billions 

of users deploying connected smart devices autonomously in seamless manner.  
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1.2 Problem Statement 

Nowadays, with an increased demand of spectrum-based services that leads to a 

global shortage, revolutionary 5G networks with unprecedented data speeds are inevitable.   

In this context, a filter is a vital component to segregate between the desired and undesired 

signal frequencies for future 5G mobile networks.  

 

The key problem in filter designs is that the passband loss is inversely proportional 

to the filter bandwidth. Therefore, an extremely high resonator Q factor must be used for 

the purpose of very narrow band applications, in order to realize the design of a very sharp 

filter with a low passband loss.  

 

The planner Microstrip filter cannot be used to design a filter at the millimeter-

wave band due to its inherent small Q factor, large insertion loss, and poor stopband 

suppression [12-15]. Similarly, the coaxial filter is not a suitable candidate because it 

gives a Q factor of at most 5,000, and the cut-off frequency is limited.  

 

The aforementioned problems in the current filter technologies lead to the need 

for innovation in waveguide filters. The waveguide filter offers a very high Q resonator 

factor, achieves low passband loss, insertion loss, and high suppression requirements [12-

15].  Indeed, the waveguide filter can be realized as a viable technology to be used in 5G 

cellular communication networks. In principle, the electromagnetic wave energy is 

propagated through the air inside the guide, rather than other conventional filters whereby 

the electromagnetic wave energy propagates in a conductor. The designed bandpass filter 

will exploit this advantage for improving the performance in terms of an increased 

bandwidth, leading to a higher data transfer rate to meet the demand of fast spectrum-

based services.  

 

 

 

 

 



4 
 

1.3 Objectives of Study  

 

The objectives of this project are two-fold: 

• To design a millimeter-wave iris waveguide bandpass filter to discriminate 

between the desired and undesired frequencies signals for future 5G 

communication networks; 

• To simulate the millimeter-wave waveguide bandpass filter by using the HFSS 

simulation software as well as analyze and compare the results with those from 

theoretical models. 

 

1.4 Scope of Study  

With respect to the objectives set forth, this dissertation concentrates on the following 

topics as the scope of study: 

• Understanding 5G technology and millimeter-wave bands; 

• Understanding Maxwell equations and the basic theorem of waveguides; 

• Understanding waveguide bandpass filter design techniques; 

• Specifying waveguide bandpass filter specifications; 

• Designing and deriving a mathematical model for the 28 GHz millimeter-wave 

iris waveguide bandpass filter based on the following design specifications 

Passband   27.70 GHz – 28.30 GHz 

Return loss   ≥ 10dB 

Stopband insertion loss ≥ 40dB at 27.25 GHz 

      ≥ 40dB at 28.75 GHz 

• Learning the HFSS 3D simulation software;  

• Designing the simulation model in HFSS;   

• Performing S-parameters simulation using HFSS; 

• Tuning and Optimizing the waveguide filter parameters; 

• Analyzing the waveguide filter performance. 
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1.5 Dissertation Organization  

The dissertation is composed of 5 chapters, including this introduction chapter. 

The introduction chapter presents the background of the project, the problem statement, 

the objectives and scope of study. Chapter 2 mainly concentrates on the literature review. 

It contains all relevant theories, hypotheses, and data which are relevant to the objectives 

and scope of this project.  

Chapter 3 discusses the methodology to achieve the objectives of the project. The 

project methodology covers background research, filter specifications, mathematical 

model, HFSS 3D model, simulation study, filter parameter tuning and optimization. 

Chapter 4 contains the simulation results and discussion. This chapter presents the 

findings and outcomes of the project work. Mathematical modelling and S-parameters 

simulation results are analyzed and discussed.  

In chapter 5, conclusions of this dissertation are summarized, and suggestions for 

future research are provided.   
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CHAPTER 2  

LITERATURE REVIEW  

 

2.1 Introduction to Waveguide 

A waveguide consists of a hollow metallic pipe or a conductive tube with an 

uniform cross-section [16, 17]. It is a structure which directs the propagation of an 

electromagnetic wave in a particular direction within the interior of the waveguide by 

confining the electromagnetic wave energy.  Waveguide is a promising element for the 

bandpass filter design because it has a high Q factor, low passband and insertion loss, and 

high power handling capability [12-15] when comparing with Transverse Electromagnetic 

(TEM) resonators and coaxial designs. Figure 2.1 shows the two common types of 

waveguides: (a) a rectangular waveguide; (b) a circular waveguide. 

 

Figure 2. 1: Two common types of waveguide: (a) a rectangular waveguide; (b) a circular waveguide. 

[17] 
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2.2 Basic of TEM, TE, TM and Hybrid Propagation  

According to the theory of waveguide, there are a few different types of 

electromagnetic waves that can propagate through the waveguide. The propagation 

modes vary upon the types of energy and the nature of the medium. Four basic 

electromagnetic waves and their corresponding propagation characteristics [17-23] are 

discussed in the following section, while Figure 2.2 illustrates the propagation 

characteristics of the TE, TM and TEM modes.  

2.2.1 Transverse Electric (TE) Waves 

The TE waves are sometimes known as the H waves. The main propagation 

characteristic of the TE waves is such that the electric field (E) vector is always 

transverse to the direction of propagation, while the magnetic field (H) vector is not 

purely transverse, i.e., Ez = 0, Hz ≠ 0. 

2.2.2 Transverse Magnetic (TM) Waves  

The TM waves are sometimes known as the E waves. The main propagation 

characteristic of the TM waves is such that the magnetic field (H) vector is always 

transverse to the direction of propagation, while the electric field (E) vector is not purely 

transverse, i.e., Ez ≠ 0, Hz = 0. 

2.2.3 Transverse Electromagnetic (TEM) Waves 

A waveguide does not support the TEM propagation mode because it is only 

made up of a single conductor. The main propagation characteristic of TEM waves is 

such that both the magnetic field (H) vector and electric field (E) are always transverse 

to the direction of propagation, i.e., Ez = 0 and Hz = 0 

2.2.4 Hybrid Waves 

 The main propagation characteristic of the hybrid waves is such that both the 

magnetic field (H) vector and electric field (E) vector are not purely transverse to the 

direction of propagation, i.e., Ez ≠ 0, Hz ≠ 0 
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Figure 2. 2: TE, TM and TEM Propagation Mode [24]. 

 

2.3 Modes of Propagation 

Electromagnetic waves travel down a waveguide in different configurations, 

which are known as the propagation modes. In 1995, the Institute of Radio Engineers 

published a set of standards to represent the rectangular waveguide propagation modes 

[16]. Transverse-electric waves are denoted as TEm,n, while transverse-magnetic 

waves are denoted by TMm,n, where both m and n are integer and the values of m and 

n  range from 0 up to infinity[16]. In the set of standards, the number of half-

wavelengths of intensity (electric and magnetic) that exist between each pair of walls 

are represented by m and n, where m and n are measured along the x-axis (width, a) 

and y-axis (height, b) of the waveguide, respectively, as shown in Figure 2.3.  

 

Figure 2. 3: A rectangular waveguide; where m and n are measured along the x-axis and y-axis of the 

waveguide, respectively[16].  
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Figure 2.4 shows the electromagnetic field pattern for the TE10 mode wave. 

TE10 mode wave is known as the dominant mode because it is the most “natural” mode. 

The electric field (or E field) vectors are parallel to each other and perpendicular to the 

wide face of the guide. The amplitude is the greatest at the midway between the narrow 

walls, and decreases to zero at the walls, in a cosine fashion. The magnetic field (or H 

field) vectors (dashed lines) are also parallel to each other and perpendicular to the 

electric vectors. The magnetic intensity is constant in the vertical direction across the 

guide section. Notice that the wave propagates in the longitude direction of the 

waveguide, perpendicular to the E and H vectors. 

 

Figure 2. 4: The end view, side view and top view of the electromagnetic field pattern for TE10 mode 

wave[16]. 

A waveguide acts as a high-pass filter in that it passes only information at 

frequencies above the minimum or cut-off frequency. Other signals below the cut-off 

frequency will be attenuated. At frequencies above the cut-off frequency, when the 

propagation mode order becomes higher, the field configurations become more 

complicated. The waveguide cannot be operated at frequencies at which these higher 

modes can propagate. The TE10 mode is desired because it caters for the smallest 

possible size waveguide with respect to a given frequency of operation. 
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2.4 Millimeter Wave Propagation Loss 

Unlike other low frequency waves, the millimeter waves open up more 

spectrum, but, at the same time, suffer from a higher wave propagation loss, as 

compared with other communication systems [1, 2, 5]. This phenomenon is related to 

the high carrier frequency characteristics. Therefore, generating and receiving a 

millimeter wave signal is a challenge, but the biggest enemy with these high frequencies 

is the propagation media. The propagation characteristics and propagation loss of 

millimeter waves must be taken into account when the millimeter wave band 

technology is utilized as the backbone of future 5G cellular networks. A lower 

frequency spectrum can propagate for a longer distance, and can easily penetrate 

through buildings owing to its long wavelength. However, a millimeter wave which has 

a short wavelength can only propagate over a short distance, and cannot penetrate 

through solid materials very well [1, 2, 7]. 
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Table 2.1 shows the attenuation level for some common materials [1, 2]. Certain 

building materials such as brick and concrete have high attenuation levels. They may 

keep the millimeter waves transmitted from the base station to be confined to streets 

and some other outdoor structures, although some of the signals may manage to reach 

inside the buildings through glass windows and wood doors which have low attenuation 

levels.  

Table 2. 1 The attenuations level for different materials [1, 2] 

 

 

In millimeter waves, the transmission loss is accounted for principally by the 

free space loss. However, the millimeter wave band also suffers from additional 

propagation losses such as the atmospheric absorption loss. Atmospheric absorption 

losses occur when the millimeter wave propagated through the mother earth are 

absorbed by water vapor, oxygen molecules, and other atmospheric gaseous[25]. At 

certain frequencies, the losses are higher, coinciding with the mechanical resonant 

frequencies of the gas molecules.  
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Figure 2.5 shows the atmospheric absorption losses at different frequencies 

across the millimeter-wave band. The blue circles show several peaks which the 

attenuation level is high due to the absorption of millimeter waves by atmospheric 

absorption.  The green circles indicate frequencies with the attenuation level similar to 

the current communication systems. On the other hand, we can notice that the white 

colour circle shows the attenuation levels at 28 and 38 GHz (0.06 dB/km and 0.08 

dB/km, respectively), which appear to be the lowest, providing the feasibility of 

millimeter-wave communication at such frequencies. For this reason, these frequencies 

are suitable candidates for future 5G cellular networks [8, 11, 26, 27]. 

 

Figure 2. 5: The atmospheric absorption losses at different frequencies across the millimeter-wave band. 

[8, 11]. 

 

 

 

 

 

 

 



13 
 

2.5 Skin Effect 

The skin effect is defined as the tendency of electromagnetic wave energy to 

penetrate into the surface of a conductor only up to a certain depth [28, 29]. As shown 

in Figure 2.6,   when an electromagnetic wave energy is transmitted along a conductor, 

the current flows only concentrate between the outer surfaces (circumference) to a level 

called ‘skip depth’ of the conductor. This means that although the conductor may have 

a few inches of thickness, only the surface up to the skin depth of the conductor carries 

current. The current, electric field, and magnetic field decay exponentially with the 

distance from the circumference of the conductor. 

 

Figure 2. 6: Skin depth of a conductor [29] 

In short, the skin depth measures the deepness of the current, electric field, and 

magnetic field that can be penetrated into a conductor.  It  can be calculated by using the 

following equation [30]: 

 𝑺𝒌𝒊𝒏 𝑫𝒆𝒑𝒕𝒉, 𝜹𝒔 = √
𝟐𝝆

𝟐𝝅𝒇𝝁𝒐𝝁𝒓
   (𝒎) 2.1 

where: 

𝝆 = 𝒃𝒖𝒍𝒌 𝒓𝒆𝒔𝒊𝒕𝒊𝒗𝒊𝒕𝒚 (Ω . 𝒎) 

𝒇 = 𝒇𝒓𝒆𝒒𝒖𝒆𝒏𝒄𝒚 (𝑯𝒛) 

𝝁𝒐 = 𝒑𝒆𝒓𝒎𝒆𝒂𝒃𝒊𝒍𝒊𝒕𝒚 𝒐𝒇 𝒇𝒓𝒆𝒆 𝒔𝒑𝒂𝒄𝒆 = 𝟒𝝅 . 𝟏𝟎−𝟕(𝑯/𝒎) 

𝝁𝒓 = 𝒓𝒆𝒍𝒂𝒕𝒊𝒗𝒆 𝒎𝒂𝒈𝒏𝒆𝒕𝒊𝒄 𝒑𝒆𝒓𝒎𝒆𝒂𝒃𝒊𝒍𝒊𝒕𝒚 

 

Based on Equation (2.1), we can observe that when the frequencies become 

higher, the skin depth shrinks. This indicates that at higher frequencies, the field is more 

difficult to penetrate into the surface of the conductor. Figure 2.7 shows a graph of skin 

depth versus frequency for some common conductors [30]. Notice that different 

materials of the conductor do not have a significant effect on the skin depth. 
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Figure 2. 7: A graph of skin depth versus frequency[30] 

Increasing the applied frequency will lead to an increase in the inductive 

reactance of the conductor. Due to the high noise frequency, the charge is being pushed 

to the surface of the conductor [31], as shown in Figure 2.8. Overcrowded electrons at 

the surface of the conductor will experience an insufficient space to propagate, therefore 

increasing the friction among them.  As a result, heat energy is produced and dissipated 

to the surrounding in the form of heat loss. 

 

Figure 2. 8: The skin effects at high frequency noise [31] 
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In waveguides, the current flows along the inner surface of the guide. But, a 

waveguide consists of four walls for the current to propagate, increasing the total 

current-caring area as compared with other conductors such as coaxial cable and copper 

wire [32]. This allows the electrons to have more space to move, and less friction is 

produced. Therefore, a waveguide has a low level of loss due to the skin effect. 

 

2.6 Chapter Summary  

 A literature review covering the scope of studies of this dissertation is presented 

in this chapter. Relevant publications that support the following discussion topics have 

been cited. Firstly, an introduction to waveguide theory is provided. Then, the differences 

between waveguide and TEM transmission line is analyzed and discussed. Next, the 

fundamental principles of TEM, TE, TM and hybrid waves and their corresponding 

propagation characteristics are summarized. Besides, the rectangular waveguide 

propagation mode and the skin effect are analyzed. Lastly, the millimeter wave 

propagation loss is discussed. The attenuation levels at 28 GHz is the lowest across the 

millimeter-wave band, providing the feasibility of millimeter-wave communication at this 

frequency for future 5G communication networks.
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CHAPTER 3  

METHODOLOGY 

 

3.1 Research Methodology   

A generalized research methodology has been followed in this dissertation to 

perform the iris waveguide bandpass filter design. Figure 3.1 depicts a flow chart 

pertaining to different phases of the waveguide bandpass filter design methodology 

adopted in this project.  The activities in each phase of the design methodology are 

discussed in detail in this chapter.  
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Figure 3. 1: The flow chart for the iris waveguide bandpass filter design methodology 
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3.1.1 Understanding Research Background  

This project starts with a general study and understanding of future 5G cellular 

communication network technology and millimeter-wave frequency band. A lot of 

relevant information, which includes the theory of waveguide, Maxwell theorem, 

waveguide propagation mode, design techniques of bandpass waveguide filters, 

waveguide sizes and dimension, propagation losses of millimeter-wave, skin effects, has 

been gathered from various resources such as reference books, e-books, journals, 

conference papers and websites.  

 

3.1.2 Specifying Filter Specifications 

 Based on the literature review pertaining to the background research, the 

propagation loss of millimeter-wave at 28 GHz is the lowest (0.06dB/km), proving the 

feasibility of millimeter-wave communication at this frequency. Therefore, the focus of 

this project is to design a WR-34 band (22-33GHz) millimeter-wave iris waveguide 

bandpass filter that operates at the center frequency of 28 GHz, with its relative bandwidth 

of 2.14%, ranging from 27.70 GHz to 28.30 GHz, to discriminate the wanted and 

unwanted signal frequencies for future 5G communication networks. The detailed design 

specifications of the filter are as follows:  

Passband   27.70 GHz – 28.30 GHz 

Return loss   ≥ 10dB 

Stopband insertion loss ≥ 40dB at 27.25 GHz 

      ≥ 40dB at 28.75 GHz 

 

 The design must take the size and dimension of a rectangular waveguide into 

consideration as they determine the standard operating frequency range of the waveguide 

as well as other factors including attenuation level, mechanical size and weight, etc. A 

suitable waveguide enables a complete coverage of the frequency spectrum for a given 

application. Table 3.1 shows the rectangular waveguide standards and specifications.  
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Table 3. 1 The rectangular waveguide standards and specifications [33] 

 

A suitable rectangular waveguide to meet the design specifications is the WR-34 

band waveguide, with its operating frequency range from 22 to 33 GHz. The lowest order 

mode, TE10 cut-off frequency for the WR-34 band waveguide is 17.357 GHz, and its 

internal dimensions are 0.340 inches x 0.170 inches. 
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3.1.3 Deriving Mathematical Model 

The next step is to derive with a mathematical model of the 28 GHz center 

frequency iris waveguide bandpass filter that meets the design specifications. This step is 

carried out by using a mathematical package, such as MATLAB or Maple. 

The mathematical model derivation process commences by analyzing the level of 

ripple in the passband. The level of ripple, 𝜀, can be determined by using the following 

formula [17]: 

 𝜀 = (
1

1 − 10− 
𝐿𝑅
 10

− 1)

1
2

 3.1 

where 

 LR = Return Loss in dB 

The two guide wavelengths, λg1 and λg2, for the WR-34 waveguide can be 

determined using the following equation[17]:  

 
λg =

λ

(1 − (
2𝜋𝑓𝑐
2𝜋𝑓

)
2

)

1
2

 
3.2 

where 

f = Frequency 

fc = Cut-off frequency of the waveguide 

λ = Wavelength  

c = Speed of light 

 

The guide wavelength, λg0, when the waveguide is half wavelength long can be 

calculated using [17]: 

 λg0 =
λg1 +  λg2

2
+

1

𝜋
(

λg1 cos (
𝜋λg2 
2λg1

) + λg2 cos (
𝜋λg1 
2λg2

)

sin (
𝜋λg2 
2λg1

) + sin (
𝜋λg1 
2λg2

)
) 3.3 
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The attenuation constant, α, is obtained using [17]: 

 α =  (
λg1

λg0
 sin (

𝜋λg0

λg1
) )

−1

 3.4 

 

The next step is to determine the required filter order, N. The filter order can be 

determined by analyzing the following insertion loss function, L [17] subject to different 

settings of N, whereby  N is chosen to meet the most severe specification with respect to  

the insertion loss. 

 𝐿 = 10 𝑙𝑜𝑔10 (1 + 𝜀2𝑇𝑛
2 (

αλg

λg0
 sin (

𝜋λg0

λg
))) 3.5 

where 

𝑇𝑛 is the Chebyshev Polynomials  

 

Next,  calculate the characteristics impedance of free space, η, as follows  [17].  

  η =  sinh (
1

𝑁
sinh−1 (

1

𝜀
)) 3.6 

 

The characteristic impedance,  𝑍𝑟  and characteristic admittance,  𝐾𝑟,𝑟+1 , values 

(normalized to 1 ohm) are then determined, as follows [17]: 

𝑍𝑟 =
2α

η
sin (

(2𝑟 − 1)𝜋

2𝑁
)

−
1

4ηα
{

η2 + 𝑠𝑖𝑛2 (
𝑟𝜋
𝑁

)

sin
(2𝑟 + 1)𝜋

2𝑁

+
η2 + 𝑠𝑖𝑛2 (

(𝑟 − 1)𝜋
𝑁 )

sin
(2𝑟 − 3)𝜋

2𝑁

} 

3.7 

with 

 𝑧0 = 𝑍𝑁+1 = 1 3.8 

for r = 1, … , N, and  
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𝐾𝑟,𝑟+1 =

(η2 + 𝑠𝑖𝑛2 (
𝑟𝜋
𝑁 ))

1
2

η
 

3.9 

for r = 0, … , N. 

 

The next step is to determine the respective susceptances of the inductive 

irises, 𝐵𝑟,𝑟+1, by the following formula [17]: 

 𝐵𝑟,𝑟+1 =
(𝑍𝑟,𝑟+1)

1
2

𝐾𝑟,𝑟+1
−

𝐾𝑟,𝑟+1

(𝑍𝑟,𝑟+1)
1
2

  3.10 

for r = 0, … , N. 

 

The phase lengths,  ψ𝑟  of the waveguide between irises are  obtained, as 

follows[17]: 

 ψ𝑟 =  𝜋 −
1

2
⌊cot−1 (

𝐵𝑟−1,𝑟

2
) + cot−1 (

𝐵𝑟,𝑟+1

2
)⌋ 3.11 

for r = 1, … , N. 

 

The physical lengths of the waveguides between irises, l𝑟 are  given by Equation 

3.12 [17]. Each physical length is measured from the centerline of one iris to the centerline 

of the next. 

 l𝑟 =  
ψ𝑟λg0

2𝜋
 3.12 

for r = 1, … , N. 
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The purely lumped-inductance discontinuities having shunt reactance,  𝑋𝑟,𝑟+1, is 

given by [34] 

 
𝑋𝑟,𝑟+1

𝑍0
=

𝐾𝑟,𝑟+1

𝑍0

1 − (
𝐾𝑟,𝑟+1

𝑍0
)

2  3.13 

for r = 0, … , N. 
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Lastly, the dimensions of the coupling irises are determined with the aid of chart 

in Figure 3.2. 

 

Figure 3. 2: Shunt reactance of symmetrical inductive window in rectangular waveguide [34] 
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3.1.4 HFSS Simulation  

Learning the HFSS simulation software is an essential part of this project. It 

provides the necessary knowledge to formulate the 3D structure of the filter as well as to 

carry out the simulation and perform filter analysis. The mathematical model is validated 

by constructing a working simulation model using the HFSS simulation software to 

produce the desired outcome. The HFSS simulation steps include: 

1. Designing HFSS 3D model  

2. Setting up design simulation  

3. Performing S-parameters simulation 

4. Tuning and optimizing filter parameters 

 

The details of each of the simulation steps will be discussed in Chapter 4.  
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3.2 Key Project Milestones  

The project milestones mark the significant steps along the final year project 

timelines. The project milestones are important to ensure that the project progresses on-

track according to the planned timelines. 

 

3.2.1 Final Year Project 1 Milestones 

 Table 3.2 shows the milestones of final year project 1. The deliverables and due 

dates of the milestones are shown. 

Table 3. 2 Milestones of Final Year Project 1 

Milestone Deliverable Week 

Research 

Background 

• Learn future 5G technology and mm-

wave band frequency 

• Understand waveguide theory, Maxwell 

theorem, bandpass filter design 

techniques, waveguide propagation 

mode and propagation losses, and 

related theories.   

6 

Mathematical Model 

Derivation  

• Derive a mathematical model for 

waveguide bandpass filter  

10 

HFSS 3D Model 

Design 

• Design and construct the 3D model 

waveguide bandpass filter based on the 

mathematical model 

14 
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3.2.2 Final Year Project 2 Milestones 

 

 Table 3.3 shows the milestones of final year project 2. The deliverables and due 

dates of the milestones are listed. 

Table 3. 3 Milestones of Final Year Project 2 

Milestone Deliverable Week 

Setup of Design 

Simulation 

• Assign waveguide materials 

• Set up waveguide boundaries conditions 

• Set up excitation port 

2 

S-parameters 

Simulation 

• Specify the simulation options 

• Validate the design setup  

• Create the S-parameters report  

• Analyze the filter response  

7 

Filter Parameter 

Tuning and 

Optimization 

• Fine-tune and optimize the filter 

parameters to achieve the desired filter 

response.  

10 
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3.3 Final Year Project Timeline (Gantt-Chart) 

 

3.3.1 Final Year Project 1 Timeline 

Table 3.4 shows the final year project 1 timeline. The completed activities are highlighted in green while the important 

due dates are highlighted in red.  

Table 3. 4 Gantt chart of final year project 1 
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3.3.2 Final Year Project 2 Timeline 

 

Table 3.5 shows the final year project 2 timeline. The completed activities are highlighted in green while the important 

due dates are highlighted in red.  

Table 3. 5 Gantt chart of final year project 2 
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3.4 Chapter Summary  

 

A generalized research methodology to perform the iris waveguide bandpass filter 

design is presented. The activities in each phase of the design methodology are explained 

in detail. Besides that, the key project milestones and the corresponding Gantt chats of 

final year projects 1 and 2 are included.
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CHAPTER 4  

RESULTS AND DISCUSSION 

 

4.1 Theoretical Design of the Iris Waveguide Bandpass Filter 

 

In this project, the aim is to design a rectangular waveguide bandpass filter that 

satisfies with the specifications in Table 4.1. 

 

Table 4. 1 Rectangular waveguide bandpass filter specifications 

Filter Parameter Specification 

Centre Frequency  28 GHz 

Passband Range 27.70 GHz to 28.30 GHz 

Lower Passband Frequency (fp1) 27.70 GHz 

Upper Passband Frequency (fp2) 28.30 GHz 

Lower Stopband Frequency (fs1) 27.25 GHz 

Upper Stopband Frequency (fs2) 28.75 GHz 

Lower Stopband Insertion Loss (LA1) ≥ 40 dB  

Upper Stopband Insertion Loss (LA2) ≥ 40 dB  

Passband Return Loss (LR) ≥ 10 dB 

 

Based on the specifications in Table 4.1, the ripple level of the waveguide 

bandpass filter is determined using Equation 3.1, which yields   

ε = 0.100
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The two guide wavelengths, λg1 and λg2, for the WR-34 waveguide are 

determined using Equation 3.2, which yields  

λg1 = 0.01389686557 m 

λg2 = 0.01342144788 m 

 

The guide wavelength, λg0, when the waveguide is half wavelength long is 

calculated using Equation (3.3), which yields 

 λg0 = 0.01365916085 m 

 

From Equation (3.4), the attenuation constant, α, is determined, i.e.,  

  α = 18.29975928 
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The required filter order, N, is then determined by using Equation 3.5, subject to different 

N settings. When N = 1, we have  

  𝑇1(𝑥) = 𝑥 4.1 

   

Substituting 𝑇1(𝑥) into Equation 3.2 gives the filter frequency response shown in Figure 

4.1. 

 

Figure 4. 1: The filter frequency response when N=1 
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When N = 2, we have 

  𝑇2(𝑥) = 2𝑥2 − 1 4.2 

   

Substituting 𝑇2(𝑥) into Equation 3.2 gives the gives the filter frequency response shown 

in Figure 4.2. 

 

Figure 4.2: The filter frequency response when N=2 
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When N = 3, we have 

  𝑇3(𝑥) = 4𝑥3 − 3𝑥 4.3 

 

Substituting 𝑇3(𝑥) into Equation 3.2 gives the filter frequency response shown in Figure 

4.3. 

 

 

Figure 4. 3: The filter frequency response when N =3 
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When N = 4, we have 

  𝑇4(𝑥) = 8𝑥4 − 8𝑥2 + 1 4.4 

   

Substituting 𝑇4(𝑥) into Equation 3.2 gives the filter frequency response shown in Figure 

4.4. 

 

Figure 4. 4: The filter frequency response when N = 4 
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When N = 5, we have 

  𝑇4(𝑥) = 16𝑥5 − 20𝑥3 + 5𝑥  4.5 

 

Substituting 𝑇5(𝑥) into Equation 3.2 gives the filter frequency response shown in Figure 

4.5. 

 

Figure 4. 5: The filter frequency response when N =5 

 

 From Figure 4.5, when N=5, notice that the stopband insertion loss is ≤ -  

40dB at 27.25 and 28.75 GHz, respectively. This response meets the filter specifications, 

i.e., satisfying the most severe specification with respect to the insertion loss. Therefore, 

the required filter order is N = 5. 
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Having determined N=5, the characteristic impedance,  𝑍𝑟 , and characteristic 

admittance, 𝐾𝑟,𝑟+1, values (normalized to 1 ohm) are determined using Equations 3.6 to 

3.9, which yields 

𝑍1= 𝑍5 =17.78454066 

𝑍2= 𝑍4 =46.45878000 

𝑍3 = 57.45590104 

 

𝐾01= 𝐾56 =1.00 

𝐾12= 𝐾45 =1.361434818 

𝐾23= 𝐾34 =1.798472818 

 

The susceptances of the inductive irises, 𝐵𝑟,𝑟+1, are determined using Equation 

3.10, which yields  

𝐵01= 𝐵56 =3.980046390 

𝐵12= 𝐵45 =21.06604636 

𝐵23= 𝐵34 =28.69265762 

 

The phase lengths, ψ𝑟, of the waveguide between irises are then obtained using 

Equation 3.11, which yields 

ψ1= ψ5 = 2.861439277 

ψ2= ψ4 = 3.059468918 

ψ3 = 3.072000973 

 

The physical lengths, l𝑟, of the waveguides between irises are calculated using 

Equation 3.12, which yields  

𝑙1= 𝑙5 = 0.622 cm 

𝑙2= 𝑙4 =0.665 cm 

𝑙3 = 0.667 cm 

 



39 
 

Lastly, the dimensions of the coupling irises are determined with the aid of the 

chart in Figure 3.2, giving 

𝑑0 = 𝑑6 = 0.292 cm 

𝑑1 = 𝑑4 = 0.144 cm 

𝑑2 = 𝑑3 = 0.125 cm 

 

The filter design parameters are summarized in Table 4.2, while the waveguide 

filter circuit diagram is shown in Figure 4.6. 

Table 4. 2 The theoretical filter design parameters 

Design Parameter Theoretical Value  

𝑑0 0.292 cm 

𝑑1 0.144 cm 

𝑑2 0.125 cm 

𝑑3 0.125 cm 

𝑑4 0.144 cm 

𝑑5 0.292 cm 

𝑙1 0.622 cm 

𝑙2 0.665 cm 

𝑙3 0.667 cm 

𝑙4 0.665 cm 

𝑙5 0.622 cm 
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Figure 4. 6: The waveguide filter circuit diagram 
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4.2 Simulation of a Waveguide Bandpass Filter Prototype Using HFSS 

4.2.1 Creating New Project 

The simulation procedure starts with creating a new project, which saves all the 

data associated with the waveguide bandpass filter prototype.   Click on Project > Insert 

HFSS Design.  A 3D modeler window appears on the screen, as shown in Figure 4.3. The 

green, red and blue lines in the HFSS 3D Modeler window represent the x, y and z axes, 

respectively.  

 

Figure 4. 7: The HFSS 3D modeler window 

4.2.2 Selecting the HFSS Solution Type 

 To set the solution type, click on HFSS > Solution Type. The solution type 

window appears on the screen, as shown in Figure 4.4. Select the Driven Model for the 

solution type for the filter prototype. The Driven Model is used to calculate the model 

based on S-parameters “driven” by a source. The S-matrix solution is expressed in terms 

of the incident and reflected powers of the waveguide model. 
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Figure 4. 8: The HFSS solution type window 

 

4.2.3 Setting the Measuring Unit of the Waveguide Model 

 To set the model measuring unit, go to Modeler > Unit. The “Set Model Units” 

window appear on the screen, as shown in Figure 4.5. The waveguide measuring unit 

should be in mm. 

 

Figure 4. 9: The HFSS set model units window 

 

4.2.4 Creating the Waveguide 3D Model  

 To draw the rectangular waveguide, go to the “Draw” Menu and click on “Box”.  

The first object that needs to be drawn is the hollow tube of the rectangular waveguide. 

The hollow tube of the waveguide can be drawn by specifying the staring position of the 

box, which is followed by entering the X-Size, Y-Size, and Z-Size of the box, respectively. 

In this project, WR-34 is chosen with the inner dimension of 8.636mm x 4.318mm. These 

values represent the X-Size and Y-Size, respectively. For the Z-Size, a random number is 

assigned as the final Z-Size of the waveguide is not fixed yet, and will be determined later 
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during the optimization step. Figure 4.6 shows the properties window for the coordinates 

and size of the box. 

 

Figure 4. 10: The properties window for the coordinates and size of the box 

The next step is to draw the conductive tube of the rectangular waveguide. Follow 

the same step as mentioned above, but with the conductive tube of the waveguide slightly 

bigger than the hollow tube of the waveguide. After that, go to Modeler > Boolean > 

Substrate to substrate the hollow tube from conductive tube of the rectangular waveguide. 

This is to ensure that the rectangular waveguide structure consists of a conducting wall 

with a uniform cross-section hollow center. Figure 4.7 shows the 3D structure of the 

rectangular waveguide in HFSS. 

 

Figure 4. 11: The 3D structure of a rectangular waveguide in HFSS 
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Lastly, the posts that act as shunt inductive discontinuities connected across the 

broad wall of the guide need to be drawn. Go to the “Draw” menu and click on “Cylinder” 

to draw the posts. A total of 6 posts are required based on the derived mathematical model. 

The lengths between each post and the diameter of every other post are specified by 

following the derived mathematical model in Table 4.2. The height of all the posts is 

8.64mm (height of the guide). The final 3D structure of the waveguide bandpass filter 

with irises is shown in Figure 4.8. 

 

Figure 4. 12: The 3D structure of the bandpass filter with irises 

 

4.2.5 Assigning the Waveguide Materials 

 After completing the 3D modelling, right click on the 3D waveguide model to 

access the 3D Modeler menu. Select “Assign Material” and a Select Definition window 

appears, as shown in Figure 4.9. Assign “Aluminum” for both the conducting wall and 

the irises of the waveguide, while assign “Air” for the hollow tube of the guide.  
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Figure 4. 13: The Select Definition window 

 

4.2.6 Setting the Boundary Conditions 

 The objective of setting the boundary conditions is to specify the guide field 

behavior at the edges of the problem region and object interfaces. The Perfect E category 

should be assigned to the 3D waveguide structure expect the hollow tube. Go to HFSS > 

Boundaries > Assign > Perfect E.  

 

4.2.7 Setting the Excitation Port 

 A wave port is the surface where the signals enter and leave the guide. Right click 

on the 3D Modeler Window and activate “Select Faces”. In the Select Faces Mode, right 

click on the cross-section area of the hollow tube, and go to Assign Excitation > Wave 

Port. In the Wave Port: General step, key in the wave port name and click “Next”. For 

this project, the number of modes required is 1, therefore one wave port integration line 

must be drawn from the middle bottom of the cross-section area of the hollow tube to the 
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top, as shown in Figure 4.10. Next, another wave port needs to be assigned at the other 

end of the guide. The same steps are followed. 

 

Figure 4. 14: Assigning the waveguide wave port 

 

4.2.8 Generating a Solution  

 A solution setup is added in order to specify how the software will compute the 

solution. This step can be accomplished by going to HFSS > Analysis Setup > Add 

Solution Setup. A Solution setup window appears. Set the Solution Frequency to 28 GHz, 

and accept all other default settings. After that, go to HFSS > Analysis Setup > Add 

frequency Sweep.  An “Edit Sweep” dialog appears, as shown in Figure 4.11. The 

frequency sweep should start from 25GHz and end at 31 GHz, since the waveguide center 

frequency is at 28GHz.  

 

Figure 4. 15: The Edit Sweep dialog box 
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4.2.9 Validation Check and Simulation Run 

Next, move on to the validation check. This step can be accomplished by accessing 

HFSS > Validation Check. A validation check window appears on the screen, as shown 

in Figure 4.12. If there is no error in the validation check, it is ready to run the simulation. 

Go to HFSS > Analyze All to run the simulation. 

 

Figure 4. 16: The HFSS validation check window 

 

4.2.10 Tuning and Optimization 

Tuning refers to the process of adjusting all the filter parameters to yield the 

desired filter response. Tuning screws are added to the waveguide filter. Specifically, 

there are 6 inductive posts and 7 tuning screws. The tuning screws are added to the center 

of each inductive post, including one before and one after the inductive post. Each tuning 

screw acts like an inductive post, but it does not have an end-to-end touch of the guide. 

For the initial design, the diameter of the tuning screw is set to 0.3 cm, and the protruding 

length is set to 0.05 cm.  Figure 4.13 depicts the 3D structure of the designed waveguide 

bandpass filter, together with all the tuning screws. The inductive posts are in blue while 

the tuning screws are in green. All the filter parameters are tuned empirically, in order to 

produce the filter response as close as possible to the desired specification.  
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Figure 4. 17: The 3D structure of the waveguide bandpass filter with inductive posts and tuning screws 

 

Next, the HFSS optimization engine is used to perform parametric analysis, 

sensitivity analysis, and optimization of all filter parameters to produce the desired filter 

response. This step can be accomplished by accessing HFSS > Optimetrics Analysis > 

Add Optimization. A setup optimization window appears on screen as shown in Figure 

4.14. Moving on, select the ‘Pattern Search’ algorithm as the optimizer.  The goal and 

condition are set according to the filter specifications.  

 

Figure 4. 18: The Setup optimization window 
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 In the Variables tab, select and include all the filter parameters for the 

optimization process.  The filter parameters optimization range is set as shown in Figure 

4.15. A total of 12 filter parameters exist, and the HFSS simulation software adjusts the 

filter parameters automatically to produce the best filter response.  

 

Figure 4. 19: The setup of the filter parameter optimization range 

 

The final optimized filter parameters, including the tuning screws design 

parameters are as follows: d0=d5=1.145mm, d1=d4=2.358cm, d2=d3=2.479mm, 𝑙1 = 

𝑙5 = 5.572mm, 𝑙2= 𝑙4 = 5.624𝑚m, 𝑙3 = 5.582 mm, h1=h7=0.648mm, h2=h6=0.025mm, 

h3=h5=0.279mm, h4=0.341mm, L= 464.62mm, th=5mm, X=3.2624mm and D=2.59mm, 

where parameter h is the height of the tuning screws, L is the length of the waveguide, D 

is the diameter of the tuning screws, th represents the thickness of the conductive tube and 

X is the length before and after the first and last inductive post from the wave port. 
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4.2.11 S-parameters Simulation Results 

 The S-parameter simulation results are shown in Figure 4.16. The results depict 

that the center frequency of the filter is at 27.995 GHz. The lower stopband frequency 

(fp1) is 27.71 GHz while the upper stopband frequency (fp2) is 28.28 GHz. Therefore, 

the passband ranges from 27.71 GHz to 28.28 GHz, with a relative bandwidth of 2.03%.  

The return loss for the entire passband is better than 7.8dB. The S-parameters simulation 

results also indicate that the filter has an upper and lower stopband insertion loss 

measurements of better than 40dB at 27.25 GHz and 28.75 GHz, respectively. This filter 

can achieve a 570 MHz bandwidth with S11 ≤ -7.8 dB and S21 ≤ 1dB. 

 

Figure 4. 20: The S-parameters simulation results 

  

4.3 Chapter Summary  

 This chapter starts with the theoretical principles for designing the iris waveguide 

bandpass filter. The mathematical model for the waveguide filter is first derived. Next, 

the detailed steps involved in constructing an HFSS simulation model are described. 

Finally, the S-parameters simulation results are analyzed and discussed.
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CHAPTER 5  

CONCLUSION AND RECOMMENDATIONS 

 

This dissertation presents the design of a WR-34 band millimeter-wave iris 

waveguide bandpass filter. The filter operates at 28 GHz center frequency.  A working 

simulation model by using the HFSS simulation software is also presented.  The main 

contribution of the designed filter in this dissertation is that it serves as a vital component 

to discriminate between the desired and undesired frequency signals for future 5G 

communication networks. The 5G technology uses millimeter-wave as its backbone 

because millimeter-wave is still under-utilized and is able to provide a large bandwidth 

and a fast data transfer rate. This technology is needed because network congestion is 

expected to occur owing to the demand capacity of the spectrum based services. 

The mathematical model and the corresponding simulation model in HFSS have 

been presented in detail in Chapters 3 and 4. In this research, the mathematical model of 

the waveguide bandpass filter is first derived based on Maxwell’s equation and the basic 

waveguide theorem. An insertion loss method with a Chebyshev polynomial is used to 

synthesize the desired filter response. A mathematical package, i.e., Maple, is used as a 

support tool for deriving the mathematical model. The mathematical model is then 

validated by constructing a working simulation model using the HFSS simulation 

software. The S-parameter simulation results depict that the center frequency of the filter 

is at 27.995 GHz. The lower stopband frequency (fp1) is 27.71 GHz while the upper 

stopband frequency (fp2) is 28.28 GHz. Therefore, the passband ranges from 27.71 GHz 

to 28.28 GHz with a relative bandwidth of 2.03%.  The return loss for the entire passband 
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is better than 7.8 dB. The S-parameter simulation results also indicate that the filter has 

an upper and lower stopband insertion loss measurements of better than 40 dB at 27.25 

GHz and 28.75 GHz respectively. This filter can achieve a 570 MHz bandwidth with S11 

≤ -7.8 dB and S21 ≤ 1dB. 

Owing to the lack of facilities to fabricate the proposed bandpass filter design, the 

target of this project is confined to mathematical formulation of the designed filter and its 

validation with a working simulation model. For further work, it is highly recommended 

to fabricate the mm-wave waveguide bandpass filter. The main purpose is to compare the 

actual filter performance with the simulation results.  
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